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Introduction and notes
This chapter includes the following topics:
■

About the NetBackup plug-in for VMware vCenter

■

Updates to this guide for NetBackup 8.0

■

Notes and recommendations on the NetBackup plug-in

■

How to access the features of the NetBackup plug-in

About the NetBackup plug-in for VMware vCenter
With the NetBackup plug-in for vCenter, you can use vSphere Client to monitor
virtual machine backups and recover a virtual machine from a backup.
You can use the plug-in to do the following:
■

View the backup status of virtual machines at various vSphere levels. For
example: Datacenter, resource pool, ESXi host.

■

View messages that are related to backups, such as snapshot deletion failure.

■

Sort and filter the backup information and export the information for analysis.

■

Recover virtual machines. (The recovery feature is optional and is not required
for monitoring virtual machine backups.)

The backup information appears on the Veritas NetBackup tab in the vSphere
Client interface.
You can start a virtual machine recovery from any of several points in the vSphere
Client interface.
See “How to access the NetBackup Recovery Wizard” on page 36.
Figure 1-1 shows a VMware environment with NetBackup servers and the NetBackup
plug-in.
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Figure 1-1

VMware environment with NetBackup plug-in
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Support for ESX and ESXi
NetBackup for VMware supports both ESX and ESXi servers. In this document,
any reference to ESXi also refers to ESX.
Note that VMware no longer supports ESX in the latest versions of vSphere.
For the VMware versions that the NetBackup plug-in supports:
Support for NetBackup in virtual environments

Updates to this guide for NetBackup 8.0
This guide contains the following changes:
■

Directions for enabling web services and for configuring web ports on the
NetBackup master server have been removed. Web services are automatically
enabled when the NetBackup 8.0 (or later) master server is installed.
Note: If the NetBackup master server is earlier than 8.0, refer to the previous
version of this plug-in guide for instructions on enabling web services.
See the following tech note for the web server tasks you must perform before
installing the master server:
https://www.veritas.com/support/en_US/article.000081350
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■

Added a procedure to install an SSL certificate from a certificate authority.
See “Installing an SSL certificate from a Certificate Authority” on page 19.

Notes and recommendations on the NetBackup
plug-in
Note the following about the NetBackup plug-in for vCenter:
■

The best screen resolution for the plug-in is 1280 x 1024 or greater.

■

The plug-in does not support auto-refresh. To refresh the display, click the
refresh button at the top.

■

In vCenter, the default retention period for vCenter events is 180 days. This
value is the recommended setting.

■

The plug-in does not support use of the https://<IP_address>:5480/ URL for
setting properties.

■

The plug-in does not support multiple vCenter servers. The plug-in is intended
for monitoring and restoring virtual machines within one vCenter server. The
plug-in Recovery Wizard can browse and restore images of virtual machines
from only one vCenter.
To use the plug-in with another vCenter, you must either unregister the current
vCenter or install another plug-in.
See “Manually unregistering the NetBackup plug-in for vCenter” on page 16.

■

If Enhanced Security Configuration is enabled in Internet Explorer on the
vSphere Client host, you may need to add the plug-in as a Trusted site. This
step is only required when you first open the Veritas NetBackup tab on the
vSphere Client host.

■

If the plug-in virtual appliance is configured on an NFS datastore, the NFS server
determines the type of disk provisioning that you can use. Note that thick
provisioning may not be available.
The following VMware article contains more information:
VMware vSphere Online Library: About Virtual Disk Formats

■

Depending on your firewall configuration, you may need to modify your firewall
rules to allow the vSphere Client host to access the plug-in host. vSphere Client
must have access to the port to which the plug-in host is configured.
Note: The default port for the plug-in host is 9445.

■

If an ESXi server is removed from vCenter and is later re-added, the events for
the VMs managed by that ESXi are lost. The plug-in shows the status of such
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VMs as "No Backup Information." The status changes as new backup events
occur for each VM.
■

See “Notes on restoring virtual machines with the NetBackup Recovery Wizard”
on page 35.

■

When the plug-in installation completes, restart the vCenter service VMware
VirtualCenter Server if you use vCenter 4.0.

■

The plug-in monitors backups that a NetBackup VMware policy made. The
plug-in does not monitor backups from other policy types.
Note the following exceptions:
■

The plug-in does not monitor backups from a VMware policy that had Use
Replication Director enabled and Application Consistent Snapshot
disabled (under Options).

■

The plug-in does not monitor all the copies that a storage lifecycle policy
(SLP) makes: It monitors the first image only.

How to access the features of the NetBackup
plug-in
Table 1-1 describes the location of the NetBackup plug-in features in vSphere
Client.
Table 1-1

Basic functions in the NetBackup plug-in

Feature

How to access in vSphere Client

Monitor the status
of virtual machine
backups

Use the Veritas NetBackup tab.

Restore a virtual
machine

You can access the Recovery Wizard in several ways.

See “Veritas NetBackup tab in vSphere Client” on page 22.

See “How to access the NetBackup Recovery Wizard” on page 36.

Note: The Recovery Wizard is optional. It is not required for monitoring
virtual machine backups.
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Installing the NetBackup
Plug-in for vCenter
This chapter includes the following topics:
■

Requirements for the NetBackup plug-in for vCenter

■

Configuration overview for the NetBackup plug-in for vCenter

■

Consistent naming for the vCenter server

■

Upgrading the NetBackup plug-in for vCenter

■

Installing the NetBackup plug-in for vCenter

■

Disabling or uninstalling the NetBackup plug-in for vCenter

■

Manually unregistering the NetBackup plug-in for vCenter

Requirements for the NetBackup plug-in for
vCenter
For a list of supported NetBackup versions, VMware versions, and other support
requirements for the plug-in, see the following document:
■

Support for NetBackup in virtual environments:
http://www.veritas.com/docs/000006177

Configuration overview for the NetBackup plug-in
for vCenter
Table 2-1 lists NetBackup configuration requirements that are related to the plug-in.
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Table 2-1

NetBackup configuration related to the plug-in

Task

Description and notes

NetBackup must be
configured to back up the
virtual machines.

For example, the NetBackup administrator must configure the
following:
■

The VMware backup host (access host).

■

The NetBackup credentials for the vCenter server.

Note: The vCenter credentials can be entered as a fully
qualified domain name or IP address. Specify the vCenter
server in the same way when you install the plug-in.
■

Policies of type VMware, with the Post events to vCenter
option set to All Events.

The NetBackup for VMware Administrator's Guide contains
details on setting up VMware policies.

Table 2-2 lists the steps for installing the NetBackup vCenter plug-in. See the
reference topic in the table for details about each step.
Table 2-2

Installing the plug-in

Step

Description

Reference topic and notes

1

Install the virtual appliance and
plug-in for vCenter.

See “Installing the NetBackup plug-in for
vCenter” on page 13.

Note: From the vSphere Client host, install
the virtual appliance while you are logged into
the vCenter. Network issues may occur if you
are logged directly into the ESXi server.
2

Install the trusted SSL certificate.

See “Installing the trusted SSL certificate”
on page 20.
Alternatively, you can install a certificate from
a certificate authority.
See “Installing an SSL certificate from a
Certificate Authority” on page 19.

Table 2-3 lists the steps for setting up the NetBackup vCenter plug-in for monitoring
backups.
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Table 2-3

Setting up the plug-in for backup monitoring

Description

Reference topic and notes

Set vCenter privileges.

See “Setting vCenter privileges for backup
monitoring” on page 22.

Table 2-4 lists the steps for setting up the NetBackup vCenter plug-in for recovering
virtual machines (the NetBackup Recovery Wizard).
Note: This wizard is not required for monitoring virtual machine backups.
Table 2-4

Setting up the plug-in for the NetBackup Recovery Wizard

Step

Description

Reference topic

1

Create an authentication token file. See “Creating an authentication token”
on page 31.

2

Authorize the plug-in to restore
virtual machines.

See “ Authorizing the plug-in to restore virtual
machines” on page 33.

3

Set vCenter privileges for virtual
machine recovery.

See “Setting vCenter privileges for recovering
virtual machines” on page 34.

Consistent naming for the vCenter server
The name of the vCenter server must be identical in the following locations:
■

In the NetBackup credentials.

■

In the NetBackup plug-in installation.

■

In the vCenter server installation.

If the fully qualified name of the vCenter server was not used during installation of
the vCenter, do the following in vSphere Client: click View > Administration >
Server Settings, then click Advanced Settings. Set the VirtualCenter.VimApiUrl
key to the fully qualified domain name.
If the vCenter server name is not entered correctly, the plug-in may not be able to
access one or more of the virtual machine images.

Upgrading the NetBackup plug-in for vCenter
Follow these steps to upgrade the plug-in from an earlier version.
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Table 2-5

Upgrading the plug-in from an earlier version

Step

Description

Reference topic and notes

1

Review the requirements for the
plug-in.

For a list of supported NetBackup versions,
VMware versions, and other support
requirements for the plug-in, see the following
document:
Support for NetBackup in virtual environments
http://www.veritas.com/docs/000006177
See “Configuration overview for the NetBackup
plug-in for vCenter” on page 10.

2

Unregister the existing plug-in.

See “Manually unregistering the NetBackup
plug-in for vCenter” on page 16.

3

Uninstall the existing virtual
appliance and plug-in.

See “Disabling or uninstalling the NetBackup
plug-in for vCenter” on page 15.

4

Install the latest version of the
virtual appliance and plug-in.

See “Installing the NetBackup plug-in for
vCenter” on page 13.

Installing the NetBackup plug-in for vCenter
The NetBackup plug-in for vCenter is provided as a virtual appliance in a
preconfigured virtual machine. The virtual appliance is available in a .zip file on the
MyVeritas website, as described in this installation procedure.
Note: After the virtual appliance is installed, it should be dedicated to hosting the
NetBackup plug-in: it should not be used for other purposes.
To install the plug-in, you need the following information about the vCenter server:
■

Host name or IP address

■

User name and password

■

Port number for the vCenter server (default is 443).
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To install the virtual appliance and plug-in for vCenter

1

If you are a new Licensing Portal user, contact your company’s administrator
or Veritas Customer Care for assistance with obtaining a MyVeritas account.
https://my.veritas.com/
You can email us at:
CustomerCare@veritas.com

2

On the MyVeritas website, log on with your MyVeritas account.

3

Under Licensing, use your entitlement ID to locate the NetBackup plug-in and
download the NetBackup_8.0_Plugins.zip file.
See the following MyVeritas guide for assistance with the Veritas Licensing
Portal:
https://www.veritas.com/support/en_US/article.000001129

4

Unzip the file and copy the plug-in .ova package to a location that is accessible
to the vSphere Client host.

5

From the vSphere Client host, log on to the vCenter server.

6

On the vCenter server, select File > Deploy OVF template.
Install the virtual appliance in vCenter, not directly in the ESXi server.

7

Browse to the location of the plug-in .ova package.
Click Next to work through the screens.

8

On the Properties screen, enter static network addresses only. Dynamic Host
Configuration Protocol (DHCP) is not supported.
If your entries do not display properly on the Properties screen, use the
Windows Display Control Panel to reduce the size of the text.
See “The Network Properties screen in the Deploy OVF Template wizard does
not display properly” on page 46.

9

Follow the remaining screens to finish installing the virtual appliance.

10 Click the NBvcplugin virtual machine and click the Console tab.
The boot process continues and asks for a new root password. Set the root
password for the virtual appliance. The boot process continues until the following
appears:
Veritas NetBackup Plugin for vCenter 8.0 Installation Program

14

Installing the NetBackup Plug-in for vCenter
Disabling or uninstalling the NetBackup plug-in for vCenter

11 Follow the installation prompts.
Enter the host name or IP address for the vCenter server, and a user name
and password. For the vCenter server port number and web server port number,
accept the defaults.
Note: You are allowed to re-enter the vCenter logon credentials five times.
Without a valid logon for the vCenter, the installation stops. Delete the
NBvcplugin virtual machine, obtain the correct logon information, and begin
the installation procedure again.

Note: You may need to modify your firewall rules to allow vSphere Client to
access the plug-in host. The vSphere Client host must have access to port
9445 of the plug-in host.
The plug-in installation begins.

12 When installation completes, restart the following:
■

vSphere Client

■

The vCenter service (restart required only for vCenter 4.0)

The virtual appliance boot process continues.

13 Verify that the plug-in has the correct time.
If the time is not correct, go to the console of the virtual appliance and use the
date command to change the time, as follows.
■

Set the date and time by means of the -s option.
For example:
date -s "Wed Feb 3 09:41:54 UTC 2016"

Note: Veritas recommends keeping the plug-in in UTC.

■

Then restart the virtual appliance.

Disabling or uninstalling the NetBackup plug-in
for vCenter
You can disable the NetBackup plug-in, or remove the virtual appliance that contains
the plug-in.

15

Installing the NetBackup Plug-in for vCenter
Manually unregistering the NetBackup plug-in for vCenter

To disable the NetBackup plug-in

1

In vSphere Client, click Plugins > Manage Plug-ins.

2

Right-click on Veritas NetBackup plugin for vCenter and click Disable.
The Veritas NetBackup tab is removed.

3

To re-enable the plug-in, right-click on Veritas NetBackup plugin for vCenter
and click Enable.

To uninstall the NetBackup plug-in

1

Right-click on the virtual appliance that contains the plug-in and select Remove
from Inventory.
If necessary, the virtual appliance can be re-imported from the datastore. For
permanent removal of the virtual appliance, click Delete from disk.

2

To reinstall the plug-in, you must manually unregister it.

Manually unregistering the NetBackup plug-in for
vCenter
Note: The NetBackup plug-in installer allows one plug-in instance per vCenter
server. You must uninstall the current plug-in before you can re-register it with the
same vCenter server.
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To manually unregister the plug-in

1

Open a web browser and use the following to log on to the vCenter Server
Managed Object Browser (MOB):
Keep all on one line:
https://vCenter Server IP or host name
/mob/?moid=ExtensionManager&method=unregisterExtension

Where vCenter Server IP or host name is the IP address or system name of
the vCenter Server where the NetBackup plug-in is registered.
If the VMware web service does not use the default port 443, specify the
following (all on one line):
https://vCenter Server IP or host name:
PortNumber/mob/?moid=ExtensionManager&method=unregisterExtension

Where PortNumber is the VMware web service port number.

2

At the prompt, enter the vCenter server credentials.
You must have the Unregister extension privilege on the vCenter server.

3

In the UnregisterExtension window, enter the following in the extensionKey
value field:
Veritas NetBackup plugin for vCenter

4

Click Invoke Method.
The NetBackup plug-in is unregistered from the vCenter Server.
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Monitoring backup status
This chapter includes the following topics:
■

Configure the NetBackup plug-in for vCenter for backup monitoring

■

Veritas NetBackup tab in vSphere Client

■

Summary display

■

Virtual Machines display

■

Events display

■

Using the Veritas NetBackup tab for backup reporting

■

How to respond to backup status

Configure the NetBackup plug-in for vCenter for
backup monitoring
Before you can use the plug-in to monitor virtual machine backups, configure the
following:
■

Optionally, install an SSL certificate from a certificate authority.
See “Installing an SSL certificate from a Certificate Authority” on page 19.

■

Install a trusted SSL certificate.
See “Installing the trusted SSL certificate” on page 20.

■

Set vCenter privileges.
See “Setting vCenter privileges for backup monitoring” on page 22.
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Installing an SSL certificate from a Certificate Authority
Optionally for the NetBackup plug-in for vCenter, you can install an SSL certificate
from a Certificate Authority that you trust. To do so, you must have both an SSL
certificate and an accompanying chain certificate. This procedure renames the alias
of the existing certificate for the Apache Tomcat® server that is packaged with the
NetBackup plug-in for vCenter. Only one alias can exist for the certificate for Tomcat.
If you do not install an SSL certificate from a CA, you may be prompted to install a
certificate.
See “Installing the trusted SSL certificate” on page 20.
To install an SSL certificate from a Certificate Authority

1

Enable SSH on the NetBackup plug-in for vCenter virtual appliance, as follows:
a.

Log on to the plug-in virtual appliance by using a vSphere console.

b.

Edit the /etc/ssh/sshd_config file and set PermitRootLogin to yes.

c.

Start the sshd service by entering the following command:
/etc/init.d/sshd start

2

Ensure that the JRE_HOME environment variable on the virtual appliance is set
to /opt/SYMCnbvcPlugin/jre.

3

Copy the SSL certificate and chain certificate to the virtual appliance. Use
secure file transfer to copy the files.

4

Stop the Apache Tomcat server by entering the following command on the
virtual appliance:
/opt/SYMCnbvcPlugin/tomcat/bin/shutdown.sh

5

Change the alias of the existing certificate in the keystore by entering the
following command on the virtual appliance:
/opt/SYMCnbvcPlugin/jre/bin/keytool –changealias –alias “tomcat”
–destalias new_alias_name –keystore /root/.keystore

The value of the new_alias_name is not significant for this operation.
Note: The keystore password is located in the Tomcat configuration file
(/opt/SYMCnbvcPlugin/tomcat/conf/server.xml)
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6

Import the chain certificate into the keystore by entering the following command
on the virtual appliance:
/opt/SYMCnbvcPlugin/jre/bin/keytool –import –alias “root”
–keystore /root/.keystore –trustcacerts –file
chain_certficiate_file

7

Import the SSL certificate into the keystore by entering the following command
on the virtual appliance:
/opt/SYMCnbvcPlugin/jre/bin/keytool –import –alias “tomcat”
–keystore /root/.keystore –file ssl_certificate_file

8

Start the Tomcat server by entering the following command on the virtual
appliance:
/opt/SYMCnbvcPlugin/tomcat/bin/startup.sh

9

Disable SSH on the virtual appliance, as follows:
a.

Edit the /etc/ssh/sshd_config file and set PermitRootLogin to no.

b.

Stop the sshd service by entering the following command:
/etc/init.d/sshd stop

Installing the trusted SSL certificate
When you first use the NetBackup plug-in for vSphere Client, you are prompted to
install a trusted SSL certificate. This certificate gets installed on the computer on
which vSphere Client is running. This certificate authenticates and secures
communication from the vSphere Client to the NetBackup plug-in host.
If you ignore the certificate warning, the same message appears whenever you log
into vCenter. To stop the messages, install the SSL certificate in the Trusted Root
Certification Authorities store, as follows.
Note: If you install a certificate from a certificate authority, you are not prompted
about an untrusted SSL certificate. Therefore, you do not have to install the
NetBackup trusted SSL certificate.
See “Installing an SSL certificate from a Certificate Authority” on page 19.
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To install the trusted SSL certificate

1

When the Security Warning appears, click Install this certificate and do not
display any security warnings for xxxx. Then click View Certificate to
examine the certificate and authenticate the identity of the connecting
NetBackup plug-in host.

2

On the Certificate dialog, click Install Certificate....

3

On the Certificate Import Wizard, click Next.

4

On the Certificate Store dialog, click Place all certificates in the following
store. Click Browse.

5

Select Trusted Root Certification Authorities and click OK.

6

Click Next.
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7

On the final screen, click Finish.
A warning message describes the certificate to be installed.

8

Click Yes.

Setting vCenter privileges for backup monitoring
Use the following procedure to set the user privileges in vCenter that the NetBackup
plug-in requires.
To set required vCenter privileges for backup monitoring
◆

If the user account to access the plug-in cannot be assigned administrator
privileges, you must set the following permissions at the vCenter level.
In vSphere Client, click Home > Roles and set the following:
To monitor virtual
machine backups

Global > Manage custom attributes
Global > Set custom attribute

Veritas NetBackup tab in vSphere Client
The NetBackup plug-in for vCenter displays backup information on the Veritas
NetBackup tab in vSphere Client.
In the vSphere Client, go to Home > Inventory > Hosts and Clusters and select
a vSphere object.
Note: You must select an object beneath the vCenter server, such as a folder,
datacenter, or ESXi host. The information that appears in the Veritas NetBackup
tab applies to the VMs within the object that you select.
Table 3-1 describes the displays that appear on the Veritas NetBackup tab.
Table 3-1

Summary, Virtual Machines, and Events displays

Display

Information shown

Summary

A summary and graphical view of backup success and backup events,
for a specified time period. Can show the current backup status for a
selected VM.
See “Summary display” on page 23.
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Table 3-1

Summary, Virtual Machines, and Events displays (continued)

Display

Information shown

Virtual Machines

Tabular view of backup information for a group of VMs.

Note: This display is available when you click on a vSphere object that
is above the level of a VM.
You can filter the information with a range of criteria. Includes an option
for customized sorting in multiple columns.
See “Virtual Machines display” on page 24.
Events

More detailed tabular view of backup information based on events. Can
show backup events for a VM or its parent object.
You can filter the information with a range of criteria. Includes an option
for customized sorting in multiple columns.
See “Events display” on page 26.

Summary display
The Summary display summarizes backup status, backup events, and backup age
for the VMs in the vSphere object that you select. If you select an individual VM,
the Summary display shows backup status and events for that VM.
Figure 3-1 shows an example of the Summary display for multiple VMs.
Figure 3-1

Summary display with backup data for multiple VMs
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The Summary display presents backup information in the following panels.
Table 3-2
Panel

Summary panels

Description

Virtual Machine(s) Shows the current backup status and related information for a particular VM or for all the VMs
that belong to the selected vSphere object.
If the panel applies to more than one VM: click on the underlined values (such as for Total or
Backup Successful) to see the details in the Virtual Machines display.
Backup Events

Shows the total number of backup events, and a breakdown of the events in three categories:
Backup Successful, Backup Failed, and Snapshot Delete Failed.
Also includes a bar chart that represents the type and number of backup events that occurred
within a specified period. Each bar represents the events that occurred on a particular day. Hover
over a bar to see the number of events for that day: the updated totals appear directly over the
chart.
You can configure the chart as follows:
■

Select the types of events that appear in the chart by clicking on the colored check boxes.

■

Move the slider to adjust the time period, or click on a Zoom time period.
You can also specify the date range by entering start and end dates in the edit boxes. The
maximum date range is one year by default.

Note: Click on the values for Total Events, Backup Successful, Backup Failed, or Snapshot
Deletion Failed to list those events in the Events display.
Virtual Machines
By Backup Age

Shows the backup age of the VMs in a bar chart. This panel is available only for a vSphere object
that is higher than the level of a VM.

Virtual Machines display
The Virtual Machines display is available when you click on a vSphere object that
is higher than the level of a VM. For each VM it lists the following: backup
information, the host or cluster, the backup policy, the master server, backup age,
VM age, and the number of consecutive failures.
Use the arrow on the right-most column header to hide or show a column. See
Figure 3-2.
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Figure 3-2

Enable or disable columns in Virtual Machines display (detail)

Note: You can move the table columns right or left (drag and drop).
You can also filter the information that appears in this display (View, Filter, Backup
Age).
The display in Figure 3-3 has been filtered to show data only for VMs that meet the
following criteria: the VM has a successful backup, the backup image is up to seven
days old, and the name of the VM contains the letters vm.
Figure 3-3

Virtual Machines display

Table 3-3 describes the options for filtering or changing the display.
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Table 3-3

Display options in the Virtual Machines display

Option

Description

View

Filters the display according to backup status (Backup Successful, Backup Failed, No Backup
Information, Excluded from reporting). For example: If View is set to Backup Successful, it displays
only the VMs that were backed up successfully.

Filter

Allows additional filtering. Select a type for Filter and enter a filter value in the contains field. For
example: If it is set to Name nfs, it displays only the VMs that have a name that contains the
characters nfs.

contains
Add

Saves the current Filter type and value (in a blue-highlighted field), to allow the addition of more
filters. Each Filter that you add further narrows the results.
Click on a filter to remove it and refresh the display.

Clear All

Removes all filtering criteria from the Filter and contains fields and refreshes the display.

Backup Age

Filters the display according to the age of the backups.

Exclude

Marks a selected VM so that its backup status and other information are not displayed.

Include

Reverses the Exclude option: Adds a VM's backup status and other information to the display.

Export

Saves the information as an Excel file (.xls), as a comma-separated text (CSV) file, or to the Clipboard.

Sort

Allows customized sorting in multiple columns. Each selection for Column and Order is a level.
For example: If one level is Name A to Z, and you add the level Policy Z to A, the information appears
as follows: the VMs appear by name in ascending order, then the VMs appear by policy name in
descending order.
To change the order in which the sorting occurs, select a level and click Move Up or Move Down.

Events display
The Events display shows backup information based on events. It can show backup
events for a single VM or for all VMs in the selected object.
Most of the filtering options on this display are described in another topic:
See “Virtual Machines display” on page 24.
Show events since filters the events according to the time period you select.
Figure 3-4 shows an Events display with unfiltered data (the default).
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Figure 3-4

Events display

Note the following:
Snapshot Delete Failed: After it creates a snapshot, NetBackup deletes the snapshot
when the backup completes. If NetBackup fails to delete snapshots, the performance
of the VM may eventually decline. In that case, you may need to delete the
snapshots manually.

Using the Veritas NetBackup tab for backup
reporting
The following procedures explain how to find VM backup status in the Veritas
NetBackup tab.
In the vSphere Client interface: Go to Home > Inventory > Hosts and Clusters
and select a vSphere object (such as a datacenter, ESXi host, or VM). The
information that appears in the Veritas NetBackup tab applies only to the object
that you select.
To find backup status for a single VM

1

Select the VM in vSphere Client.

2

Click the Veritas NetBackup tab.

3

Under Summary, Virtual Machine, see the Current Backup Status and the
Backup Events.
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To find backup status for multiple VMs

1

Select the appropriate object in vSphere Client (such as datacenter or ESXi
host).

2

Click the Veritas NetBackup tab.
The Summary display shows the backup success rate for the VMs overall.
See “Summary display” on page 23.

3

For the backup status of particular VMs, click the Virtual Machines display
and find the VMs in the Name column.
Use the View field to select the type of backup message to show (such as
Backup Successful or Backup Failed).
Use Filter to further limit the type of information that appears.
Use Backup Age to filter the display by backup age.
See “Virtual Machines display” on page 24.

To determine which VMs are not backed up

1

Select the appropriate object in vSphere Client (such as datacenter or ESXi
host).

2

Click the Veritas NetBackup tab.

3

Click the Virtual Machines display.

4

Set the View field to Backup Failed.

5

You can use Filter and Backup Age to filter the display.

6

To save the report, click Export and select an output type.

To determine the age of existing backups

1

Select the appropriate object in vSphere Client (such as datacenter or ESXi
host).

2

Click the Veritas NetBackup tab.
In the Summary display, Virtual Machines By Backup Age shows the age
of the backups (up to one day, up to seven days, and so forth).

3

For information on backup age per VM, click the Virtual Machines display and
look at the Backup Age (days) column.
Set View to All or to Backup Successful.
If necessary, use Filter to filter the displayed information.

4

To save the report, click Export and select an output type.
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How to respond to backup status
For the backup status that is reported in the plug-in, the following example actions
may be appropriate. You may need to confer with the NetBackup administrator.
Table 3-4

Tips for responding to backup status in the NetBackup vCenter
plug-in

Status

Action

Backup failures

■

■

No backup
information

■

■

■

Snapshot delete
failed

Look at the number of consecutive failures on the Virtual Machines
display.
If too many failures have occurred, export the display results and
send the file to the NetBackup administrator.
The VM may not be included in a NetBackup policy, or the Post
events to vCenter policy option may not be correctly configured.
Contact the NetBackup administrator.
The VM may be intentionally excluded from scheduled backups
(contact the NetBackup administrator). In that case, you can use
the Exclude option on the plug-in Virtual Machines display to
remove the VM's status from the display.
The ESXi server may have been removed from the vCenter server.
See “Notes and recommendations on the NetBackup plug-in”
on page 8.

NetBackup attempts to delete old snapshots at the start of each backup.
If snapshots are not deleted, you can manually delete them in vSphere
Client.
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Recovering virtual
machines
This chapter includes the following topics:
■

Configure the NetBackup Recovery Wizard

■

Notes on restoring virtual machines with the NetBackup Recovery Wizard

■

How to access the NetBackup Recovery Wizard

■

NetBackup Recovery Wizard screens

Configure the NetBackup Recovery Wizard
Note: The NetBackup Recovery Wizard is an optional feature of the NetBackup
plug-in for vCenter, for recovering virtual machines. It is not required for monitoring
virtual machine backups.
To use the NetBackup Recovery Wizard to restore virtual machines, configure the
following:
Table 4-1

Configuring the NetBackup Recovery Wizard

Step

Description

Reference topic

1

Create an authentication
token file.

See “Creating an authentication token” on page 31.

2

Authorize the plug-in to
restore virtual machines.

See “ Authorizing the plug-in to restore virtual
machines” on page 33.
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Table 4-1

Configuring the NetBackup Recovery Wizard (continued)

Step

Description

Reference topic

3

Set the required vCenter
privileges.

See “Setting vCenter privileges for recovering virtual
machines” on page 34.

Creating an authentication token
To allow the plug-in to restore VMs, you must generate an authentication token on
the NetBackup master server (or on the appliance as master server).
To create an authentication token on the NetBackup master server

1

Enter the following on the master server:
Windows
install_path\NetBackup\wmc\bin\install\manageClientCerts.bat
-create plugin_host

UNIX, Linux
/usr/openv/wmc/bin/install ./manageClientCerts -create plugin_host

plugin_host is the fully qualified domain name of the virtual machine (virtual
appliance) where the NetBackup plug-in is installed.
The manageClientCerts command returns the location of a compressed file
that contains the authentication token.

2

Provide the compressed file to the vCenter administrator.
Caution: Be sure to share or send the compressed file in a secure manner.
With the master server token, the plug-in can be authorized to restore virtual
machines.
See “ Authorizing the plug-in to restore virtual machines” on page 33.
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To create an authentication token (certificate) on the NetBackup appliance
as master server

1

To generate the certificate, see the "Manage > Certificates" topic in the
NetBackup Appliance Administrator's Guide, available from this location:
http://www.veritas.com/docs/000002217

2

Provide the compressed certificate file to the vCenter administrator.
Caution: Be sure to share or send the compressed file in a secure manner.
With the master server certificate, the plug-in can be authorized to restore
virtual machines.
See “ Authorizing the plug-in to restore virtual machines” on page 33.

Revoking an authorization token
You can delete or revoke a master server authentication token, as follows.
To revoke the authorization token

1

Enter the following on the master server:
Windows
install_path\NetBackup\wmc\bin\install\manageClientCerts.bat
-delete vCenter_plugin_host

UNIX, Linux
/usr/openv/wmc/bin/install ./manageClientCerts -delete
vCenter_plugin_host

where vCenter_plugin_host is the fully qualified domain name of the vCenter
in which the plug-in is installed.
The -delete option removes the authentication token and its compressed file
from the master server. The plug-in is no longer authorized to restore virtual
machines from backups that were made by this master server.

2

To re-authorize the plug-in for restores for this master server, create a new
token and if necessary re-add the master server in vSphere Client.
See “Creating an authentication token” on page 31.
See “ Authorizing the plug-in to restore virtual machines” on page 33.
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Listing all current authorization tokens
You can list all the master server authentication tokens that are presently in use.
To list all current authorization tokens
◆

Enter the following on the master server:
Windows
install_path\NetBackup\wmc\bin\install\manageClientCerts.bat -list

UNIX, Linux
/usr/openv/wmc/bin/install ./manageClientCerts -list

Sample output:
Client

Expiry Date

vCenter-server-1
vCenter-server-2

Thu Feb 06 16:16:51 GMT+05:30 2014
Fri Feb 07 11:22:53 GMT+05:30 2014

The command lists the vCenter servers for which the tokens were created as
well as their expiration dates. It can help diagnose communication problems
between the plug-in host and the master server when a certificate has expired.
■

For well-formatted output, set the command prompt or shell screen size to
more than 100 units.

■

Server names that are longer than 40 characters are truncated: Characters
beyond the first 40 are replaced with “...”.

Authorizing the plug-in to restore virtual machines
The NetBackup master server initiates and controls the backup of virtual machines.
To use the plug-in to restore virtual machines, you must obtain a master server
authentication token from the NetBackup administrator. Then you can authorize
the plug-in to restore the virtual machines that were backed up by that master
server.
To authorize the plug-in to restore virtual machines

1

Ask the NetBackup administrator to provide an authentication token file.
See “Creating an authentication token” on page 31.

2

Copy the authentication token file to the vSphere Client host (make a note of
the location).

3

In vSphere Client, click Home.

4

Click the Veritas NetBackup icon.
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5

Click Add/Remove Servers.

6

Enter the following to specify a NetBackup master server and its authentication
token.
Add NetBackup
Master Server

■

■

■

■

NetBackup Master Server
Enter the fully qualified domain name of the master server.
Port for NetBackup Web Services
If the NetBackup administrator has not changed the port, accept
the default (8443). Otherwise, contact the administrator for the
correct port number.
Upload Authentication Token
Click Browse to select the authentication token file that the
NetBackup administrator provided.
Click Add Server. The server is added to the list of master
servers that the plug-in can communicate with.

Note: If an "Out of sync" message appears after you add a master server, click
on the message as requested. This message can be ignored: it does not
indicate a problem in adding the NetBackup authentication token.

Note: If a "Connection Refused" message appears, the ports for the NetBackup
Web Services may not be correctly configured on the master server. Contact
the NetBackup administrator.

7

Add other master servers and their authentication tokens as needed.

8

You can also remove a master server from the list of servers, or validate the
connection from the plug-in to a master server.
Validate/Remove
NetBackup
Master Server

After the master server is added to the list, you can validate the
connection. Type or select the master server and click Validate.
Click Remove to remove the server from the list. The plug-in is
no longer able to monitor or restore the backups that the master
server performed.

Setting vCenter privileges for recovering virtual machines
Use the following procedure to set the user privileges in vCenter for the NetBackup
Recovery Wizard.
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To set required vCenter privileges for recovering virtual machines
◆

If the user account to access the plug-in cannot be assigned administrator
privileges, you must set the following permissions at the vCenter level.
In vSphere Client, click Home > Roles and set the following:

To recover virtual
machines

NetBackup Recovery > Add or Remove NetBackup Servers
NetBackup Recovery > Virtual Machine Recovery
Global > Log Event

Note: When you deploy the plug-in, NetBackup recovery privileges
are automatically enabled for the Administrator role. These privileges
allow the VMware administrator to use the NetBackup Recovery Wizard
to recover virtual machines to any destination in vCenter. To give the
recovery privileges to other users, you must enable the NetBackup
Recovery privileges for other roles.

Caution: The NetBackup Virtual Machine Recovery privilege grants global recovery
authorization. It allows users with that role to recover any virtual machine that resides
on that vCenter. Use caution when granting this privilege to users.

Notes on restoring virtual machines with the
NetBackup Recovery Wizard
Use the Veritas NetBackup Recovery Wizard in vSphere Client to restore a virtual
machine from its NetBackup image. You can restore the virtual machine to its
original location or to a different location.
Note the following about the NetBackup Recovery Wizard:
■

For the pre-requisites for using the Recovery Wizard:
See “Configure the NetBackup Recovery Wizard” on page 30.

■

The NetBackup Recovery Wizard is an optional feature of the plug-in. It is not
required for monitoring virtual machine backups.

■

The NetBackup Recovery Wizard is for recovery of an entire virtual machine,
not for recovery of individual files. To recover individual files from the virtual
machine backup, use the NetBackup Backup, Archive, and Restore interface.
See "About restore of individual files" and "Restoring individual files" in the
NetBackup for VMware Administrator's Guide.
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■

The Recovery Wizard does not support recovery of vCloud Director backup
images. To recover virtual machines into vCloud Director, use the NetBackup
Backup, Archive, and Restore interface.
See the "Use NetBackup for vCloud Director" chapter in the NetBackup for
VMware Administrator's Guide.

■

The Recovery Wizard does not use NetBackup's Instant Recovery feature.

How to access the NetBackup Recovery Wizard
In vSphere Client, you can launch the Recovery Wizard in any of three ways as
shown in Table 4-2.
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Table 4-2

Action

Three ways to start the NetBackup Recovery Wizard in vSphere
Client
Description
Right click on the virtual machine and select Veritas
NetBackup Recovery Wizard.
By default, the wizard selects the original location as
the target for the restore. You can overwrite the virtual
machine in the original location or direct the restore
to another location.

Click Home, click the Veritas NetBackup Recovery
icon, and then click Start VM Recovery Wizard.
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Table 4-2

Three ways to start the NetBackup Recovery Wizard in vSphere
Client (continued)

Action

Description
In the Veritas NetBackup tab, click the Events tab,
click on a successful backup event for the virtual
machine, and click the Recover tab.

NetBackup Recovery Wizard screens
Use the following screens to restore a virtual machine with the VMware vSphere
Client interface.

Select source virtual machine
Select the virtual machine to restore.
Table 4-3

Select source virtual machine (NetBackup plug-in Recovery
Wizard)

Field

Description

Select NetBackup
Master Server

Use the drop-down list to select the master server that made the backup.
If the master server is not in the drop-down, you must add the server to the master server
list.
See “To authorize the plug-in to restore virtual machines” on page 33.
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Table 4-3

Field

Select source virtual machine (NetBackup plug-in Recovery
Wizard) (continued)

Description

Enter Display Name Enter the virtual machine name (or portion of the name) that you want to restore, and click
or UUID or DNS Name Search.
or Host Name
Note: This field is case-sensitive.
When you access this dialog by means of Home > Veritas NetBackup > Recovery Wizard,
this field does not accept pasting values from the Clipboard. You must enter a value manually.
For security reasons, VMware does not allow pasting values into this field.
Select Client

The results of the search appear in this list.
Click the virtual machine to restore and then click Next.

Select Backup
In the NetBackup plug-in Recovery Wizard, select the backup image from which to
restore the virtual machine.
Table 4-4

Select Backup (NetBackup plug-in Recovery Wizard)

Field

Description

Select Backup

Use the drop-down to select the backup, as follows
■

■

Backup Details

Latest Backup
Selects the latest available backup image.
Manually Specify
Click this option to select a different backup image. The Browse backups button appears.
Click that button and enter a date range within which to search for images. The vmdk files
for the image you select appear under the Virtual Machine Attributes area.
A red triangle next to the date field indicates the entry of an unsupported date format. Use
the calendar icon to select a date.
The Select Backup screen in some cases allows the incorrect entry of a date.
Click Select this backup to select the backup image.

Displays the information on the backup image and the attributes of the virtual machine at the
time it was backed up.

Destination Options
Specify the destination for the restored virtual machine.
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Table 4-5

Destination Options (NetBackup plug-in Recovery Wizard)

Field

Description

Original Location

Lists the details of the original location.

Use Original
Location

Selects the original location (ESXi server, folder, resource pool, datastore, or cluster) as the
restore location. (This setting is the default.)
To accept the original location, click Next.

ESXi

The ESXi server for the restored virtual machine.
Click Change to browse for an ESXi server.

VM Folder

The folder for the restored virtual machine.
Click Change to browse for a folder.

Resource Pool

The resource pool for the restored virtual machine.
Click Change to browse for a resource pool.

Datastore or
Cluster

The datastore or datastore cluster for the restored virtual machine.

Display Name

The display name for the restored virtual machine. You can enter the name.

Click Change to browse for a datastore or datastore cluster.

Transport Modes
Select the recovery host and data transfer mode for the virtual machine restore.
Table 4-6

Recovery host and transport modes (NetBackup plug-in Recovery
Wizard)

Field

Description

NetBackup
Recovery Host

The host that performs the recovery. The default is the host that performed the backup (the
backup host).
In most cases, use the host that performed the backup. Selecting a different host as the recovery
host can result in a slow restore or a failed restore, depending on the transport mode.
For example, the restore may fail if you select the SAN transport mode in the following case:
■

The host that performed the backup used a SAN connection to access the datastore.

■

The host you select as recovery host does not have SAN access to the datastore.
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Table 4-6

Field

Recovery host and transport modes (NetBackup plug-in Recovery
Wizard) (continued)

Description

Transport Modes Determines how the restore data is sent from the recovery host to the VMware datastore. The
appropriate option depends in part on the type of network that connects the VMware datastore
to the recovery host.
Click a mode on the left and use the arrow to add it to the Selected modes in preference order
panel on the right. The first mode that is added is the first transfer mode that NetBackup tries for
the restore.
san

For unencrypted transfer over Fibre Channel (SAN) or iSCSI.

nbd

For unencrypted transfer over a local network that uses the Network Block Device (NBD) driver
protocol. This mode of transfer is usually slower than Fibre Channel.

nbdssl

For encrypted transfer (SSL) over a local network that uses the Network Block Device (NBD)
driver protocol. This mode of transfer is usually slower than Fibre Channel.

hotadd

Requires that the recovery host is in a virtual machine.
For instructions on this transport mode and on installing the recovery host in a virtual machine,
refer to your VMware documentation.

Disk Options
Select the provisioning for the restored disks.
Table 4-7

Disk options (NetBackup plug-in Recovery Wizard)

Field

Description

Same as original

Restores the virtual machine's virtual disks with their original provisioning.

Thick Provision
Lazy Zeroed

Configures the restored virtual disks in the thick format. The virtual disk space is allocated when
the disk is created. This option restores the populated blocks, but initializes vacant blocks with
zeros later, on demand.

Thick Provision
Eagerly Zeroed

Configures the restored virtual disks in the thick format. Restores the populated blocks and
immediately initializes vacant blocks with zeros (eagerly zeroed). Creation of the virtual disks
may take more time with this option. However, if the restore occurs over a SAN, the eagerly
zeroed feature may speed up the restore by reducing network communication with the vCenter
server.

Thin Provisioning

Configures the restored virtual disks in the thin format. Restores the populated blocks but does
not initialize vacant blocks or commit them.
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Virtual Machine Options
Select the recovery options for the virtual machine.
Table 4-8

Virtual machine options (NetBackup plug-in Recovery Wizard)

Field

Description

Restore BIOS UUID
instead of creating a
new

Retains the UUID of the original virtual machine (note that the UUID is a globally unique
identifier). The virtual machine is restored with the same UUID that it had before the restore.
Note the following:
■

■

If a virtual machine with the same display name but with a different UUID exists at the
target restore location, the restore fails. You must either delete the existing virtual machine
and run the restore, or keep the existing virtual machine and abandon the restore.
If you do not want to keep the existing virtual machine, you can do one of the following:
Remove the existing virtual machine, or log into the ESXi server and remove the directory
where the virtual machine resides.

Power on virtual
machine after
recovery

The recovered virtual machine is automatically turned on when the recovery is complete.

Overwrite existing
virtual machine

If a virtual machine with the same display name exists at the destination, that virtual machine
must be deleted before the restore begins. Otherwise, the restore fails. Select this option to
have the virtual machine deleted.

Retain hardware
version

This option restores the virtual machine with its original hardware version (such as 4). It
retains the original version even if the target ESXi server by default uses a later hardware
version (such as 7 or 8).
If this option is disabled, the restored virtual machine is converted to the default hardware
version that the ESXi server uses.

Network Connectivity Options
Select the networks for the recovered virtual machine.
Table 4-9

Network connectivity options (NetBackup plug-in Recovery
Wizard)

Field

Description

Select All

Selects or unselects all the networks that are available. If a network is selected, the restored virtual
machine is automatically connected to that network.
You can select individual networks for the restored virtual machine.
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Recovery Summary
Preview the recovery details.
Table 4-10

Recovery summary (NetBackup plug-in Recovery Wizard)

Field

Description

Destination

Lists the settings that are used for the recovery.

Pre-Recovery
Check Results

Click Run Pre-Recovery Check.

Recover

Starts the recovery of the virtual machine.

Verifies the credentials and appropriate paths and connectivity, determines whether the datastore
or datastore cluster has available space, and reviews other requirements. You must run this
check at least once. You can proceed with the restore even if the check fails.

This button is not available until you run a pre-recovery check.
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Troubleshooting
This chapter includes the following topics:
■

The NetBackup vCenter plug-in does not appear in vSphere Client

■

Reducing the load time for the NetBackup vCenter plug-in

■

The Network Properties screen in the Deploy OVF Template wizard does not
display properly

■

The Veritas NetBackup tab is blank

■

The Recovery Wizard does not find any backup images

■

The Recovery Wizard does not find a particular backup image

The NetBackup vCenter plug-in does not appear
in vSphere Client
The plug-in may not appear if vSphere Client fails to access the plug-in host.
In vSphere Client, click Plug-ins > Manage Plug-ins. A NetBackup plug-in message
similar to the following indicates that vSphere Client cannot connect to the plug-in.

Recommended actions:
■

Verify that the vSphere Client host can access the plug-in by name. You may
have to modify C:\Windows\System32\drivers\etc\hosts on the vSphere
Client host to correct the name resolution.

Troubleshooting
Reducing the load time for the NetBackup vCenter plug-in

■

Verify that the plug-in host (virtual appliance) is running.

■

Verify that the host name being accessed is correct. If the plug-in host is
configured with the wrong host name, delete the virtual appliance and reinstall
it.

Reducing the load time for the NetBackup vCenter
plug-in
If the plug-in takes a long time to load, too many backups may have occurred in
your environment.
To reduce the load time for the NetBackup vCenter plug-in

1

Log in to the plug-in virtual appliance using vSphere Client.
Log in as the root user and specify the password that was supplied during the
plug-in installation.

2

Open the following file in a text editor:
/etc/nbvcplugin.env

3

Find the following line in the file:
export MAX_EVENT_HISTORY_IN_DAYS=365

By default, the vCenter plug-in retrieves backup events for the last 365 days.

4

Change the numeric value of MAX_EVENT_HISTORY_IN_DAYS to a lower
positive number (non-zero). For example: 30.
This change limits the number of backup events that the plug-in retrieves. As
a result, it reduces the plug-in's initial load time.

5

Save the file and exit the text editor.

6

For this setting to take effect, enter the following commands to restart the
plug-in service:
service nbvcplugin stop
service nbvcplugin start

7

Log out of the plug-in virtual appliance.
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Troubleshooting
The Network Properties screen in the Deploy OVF Template wizard does not display properly

The Network Properties screen in the Deploy OVF
Template wizard does not display properly
During installation of the virtual appliance, the deployment wizard Network
Properties screen may display improperly if the Windows text size is set too large.
For example:

To correct the display, go to the Windows Control Panel and click Display. Set the
text size to 100%.

The Veritas NetBackup tab is blank
In vSphere Client, if an operation in the Veritas NetBackup tab results in a blank
display, close and restart the vSphere Client. Then retry the operation.
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Troubleshooting
The Recovery Wizard does not find any backup images

The Recovery Wizard does not find any backup
images
The NetBackup plug-in Recovery Wizard may encounter this problem for any of
the following reasons:
■

The vCenter name resolution for the master server IP on the plug-in host is
different from the name resolution for the master server IP on the master server.

■

The vCenter was added to the master server using its name but the plug-in was
configured using its IP.

■

The time setting on the plug-in host is incorrect.

Recommended actions:
■

Verify that the name of the plug-in on the plug-in host is identical to the name
entered under Credentials on the NetBackup master server. The following two
name entries should match:
■

On the plug-in host enter the following:
/opt/SYMCnbvcPlugin/tomcat/webapps # cat /etc/nbvcplugin.env |
grep SERVER_NAME

Example result: SERVER_NAME=vmserver.acme.com
■

Find the virtual machine server name in the Administration Console on the
NetBackup master server, under Media and Device Management >
Credentials > Virtual Machine Servers:
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Troubleshooting
The Recovery Wizard does not find a particular backup image

The name that appears in the Administration Console should match the name
that was returned on the plug-in host.
■

Verify that the time setting on the plug-in host (virtual appliance) is correct. If
necessary, set the current time using the date command.
For example:
date -s "Wed Feb 6 09:41:54 UTC 2013"

Note: Substitute the current date and time for the values in this example.
Then restart the virtual appliance.

The Recovery Wizard does not find a particular
backup image
The NetBackup plug-in Recovery Wizard may not find the backup image for a
particular VM if the VM display name contains special characters.
To locate the backup image, start the recovery as follows:
■

In vCenter, click Home, click the Veritas NetBackup Recovery icon, and then
click Start VM Recovery Wizard.

■

In the wizard, enter the VM name (full or partial) to begin recovery.
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